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Part 1. What is the flipped classroom? 
 

Anatomy of a Normal Classroom 

  

In class ​ - passive transfer of knowledge  At home ​ - active application of the knowledge 

watch lectures as classwork 
there is little interaction between instructor and learner 

do problem sets as homework 
student tries to apply knowledge alone without 

assistance 

Anatomy of a Flipped Classroom 

  

At home ​ - passive transfer of knowledge  In class​ - active application of the knowledge 

watch lectures as homework 
student reviews knowledge on their own time 

(can review as many times as needed) 

do problem sets as classwork 
applies the knowledge in a social context 

can get help from other learners or instructor  

 
Though technology is not a requirement (students can simply read a text at home), the popularity of 
hosted streaming video (such as YouTube) makes it easy to ubiquitously deliver video lessons to 
students.  
 
Studies looking at the efficacy of the flipped class in health care mainly focus on student perceptions 
(they like it better) and there are some that show improved test scores.  
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Part 2. Create Clear Objectives 
 
Bloom’s taxonomy of objectives can be split into two sections:  

● lower-order objectives focus on the acquisition of knowledge (a necessary, though usually 
passive process) 

○ Ex: List the components of the primary survey in the patient with traumatic injuries. 
● higher-order objectives focus on the application of that knowledge 

○ Ex: Perform a primary survey in a trauma simulations 
○ Ex: Evaluate the completeness of the primary survey (by the other cohort of students) 

 

REMEMBER UNDERSTAND APPLY ANALYZE EVALUATE CREATE 

List, Name, 
Identify, Show, 

Define, 
Recognize, 

Recall, State, 
Visualize 

Summarize, 
Explain, 

Interpret, 
Describe, 
Compare, 

Paraphrase, 
Differentiate, 
Demonstrate, 

Classify 

Solve, Illustrate, 
Calculate, Use, 

Interpret, Relate, 
Create, 

Manipulate, 
Apply, Modify 

Analyze, 
Organize, 
Deduce, 
Contrast, 
Compare, 

Distinguish, 
Discuss, Plan, 

Devise 

Evaluate, 
Choose, 

Estimate, Judge, 
Defend, Criticize 

Design, 
Hypothesize, 

Support, 
Schematize, 

Write, Report, 
Justify 

lecture, visuals, 
video, audio, 

examples, 
illustrations, 

analogies 

questions, 
discussion, 

review, test, 
learner 

presentation, 
writing 

exercises, 
practice, demos, 

projects, 
sketches, 

simulation, role 
play 

problems, 
exercises, case 
studies, critical 

incidents, 
discussion 

case studies, 
critiques, 
appraisals 

projects, 
develop plans, 

construct 
simulations, 

creative 
exercises 

RECALL & RECOGNITION APPLICATION & PROBLEM SOLVING 

 
Take one or two objectives from a class you are currently teaching and try to write 1-2 lower order and 
1-2 higher-order objectives:  
 

Lower Order Objectives 

 

 

 

Higher Order Objectives 
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Part 3. Use Sound Theory to Create Your Lessons 
 
These principles of e-Learning championed by Richard Mayer have been shown to improve learner 
learning when material is presented in a digital format. For a good summary on this subject, I refer you 
to Ruth Clark and Richard Mayer, E•Learning and the Science of Instruction, 3rd edition, Pfeiffer 
Publishing, August 16, 2011.  

 
Avoid bullet points and useless images 

 
Replace with relevant images 

 
Richard Mayer’s Multimedia Learning Principles 

 

People learn better... 
What Material To Include 

Multimedia ...from words and pictures than from words alone 

Modality ...from graphics and narrations than from animations and on-screen text 

Redundancy ...from graphics and narration than from graphics, narration & on-screen text 

Coherence ...when extraneous words, pictures & sounds are excluded 

Arranging The Material 

Contiguity ...when corresponding words & pictures are presented next to each other and simultaneously 

Pre-training ...when they know the names and characteristics of the main concepts ahead of time 

Signaling ...when cues that highlight the organization of the essential material are added 

Segmenting ...when material is presented in user-paced segments rather than a continuous unit 

Voice & Personalization 

Personalization ...when words are in a conversational style rather than a formal style 

Voice ...when narration is spoken in a friendly human voice rather than a machine voice 

Image ...when the speaker’s image isn’t on the screen (distracting from the material) 
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If you want to learn more about the theory behind these principles, here’s a short video: 
youtu.be/BcWSUnXz8kw 

 

 
Practice by redesigning slides of your own using these principles.  
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Part 4: Take Care With Images 

 
There are two dangers lurking when using images: copyright law and HIPAA. Most pictures obtained 
through an Internet search engine are often not licensed for reuse and put you in potential copyright 
trouble. There are, though, many resources where you can get images for reuse.  

 
Putting “chest x-ray” into a ​Google Image search 
yields mostly pictures which shouldn’t be reused. 
By selecting “Search Tools” > “Usage Rights,” the 
search can be further refined to include those 
graphics ready for reuse. Most are supplied 
under a ​Creative Commons license​ which gives 
people “a simple, standardized way to  grant 
copyright permissions to their creative work.”  
 
Another good source of images available for 
reuse is ​WikiMedia Commons​ (part of the same 
organization as Wikipedia). This site is full of 

many high quality medical images provided for public reuse (with proper attribution).  
 
Alternatively, you can take your own images. Be sure to 
follow a few rules:  
 

● Don’t use patient information without a consent 
● Remove any personal health information. Simply 

cropping (or masking) out the patient’s name and 
saving an image keeps all the information with 
the picture. It is a simple matter to “uncrop” the 
image and reveal the identifying information. 
Information may also be saved in the meta-data 
(EXIF). Search your image manipulation 
software’s documentation for the correct way to 
destructively​ edit the photo (no original 
information is saved) and remove meta-data.  

● Alternatively, you can create your own images 
with drawing programs like Photoshop or Pixelmator (bitmap image software) or Illustrator or 
iDraw (vector editing software).  

 
1. commons.wikimedia.org 
2. www.flickr.com 
3. phil.cdc.gov/phil/home.asp 
4. images.google.com​ using Search Tools to find images labeled for re-use 
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Tip 5: Create resources with familiar technology (making home modules) 

 
At home modules can be anything from assigned readings to a print out of your slides but today’s 
learners appreciate and can benefit from video lessons. However, do not make the mistake of simply 
recording yourself giving your lecture.  There are options for creating your own content.  
 

Hardware Create Content Screen Recorders Video Editing 
Software 

All-in-One 
Options 

Microphones  
- Samson 

Meteor 
- Blue Snowball 
- Blue Nessie 
- Built-in 

microphone 
 
Drawing Tablets 

- Wacom 
Bamboo 

 
 

PowerPoint / Keynote 
(has recording 
capabilities built-in) 
 
Drawing Programs 
(Paint, Illustrator, 
SketchUp) 

Camtasia 

Snagit 

Screenr 

Screencast-o-matic 

Quicktime (Mac) 

ScreenFlow (Mac) 

iShowU HD Pro (Mac) 

ScreenFlow (Mac) 
Windows Movie Maker  
iMovie / Final Cut Pro 
(Mac) 

Knowmia 

Doceri 

EduCanon 

Socrative 

Explain Everything (iPad 

/ Android) 

DoodleCast Pro (iPad) 

Vittle (Free version 

available) 

 
 
 
The classic example of the flipped classroom comes from the 
Khan Academy (see picture to the left).  What does it take the 
create content on this level? Sal Khan uses a Wacom Graphic 
tablet and stylus, headphones with a built-in boom microphone, 
and would record in his closet.  
 
 

Peter Norvig and Sebastian Thrun, creators of one of the first 
immensely popular MOOC’s in Artificial Intelligence used only 
a pen, paper and camera.  
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To get started, it’s best to use the software with which you are already 
familiar. In PowerPoint, after creating your slides using the Multimedia 
principles, you’ll go to the “Slide Show” menu and select “Record Slide 
Show.” Then you can start recording and speak your presentation while you 
advance the slides. Your built-in microphone (or attached microphone if 
you have one) will record your voice. The video comes from the screen. 
 
When you are done, pick the X labeled “End Show.” From the File menu, 
you can pick “Save as Movie…” 
 
 

 

In Keynote, you’ll do something similar. After your slides are 
completed, select “Record Slideshow…” from the Play menu. Go 
through your slides, while narrating, and the microphone will 
record your voice.  

To save it as a move, from the File menu select “Export” and 
choose “Quicktime…” 

Go ahead and give that a try.  
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Tip 5.5: Upload your Modules to the Public Domain 
 
Putting your material in the public domain has several 
benefits: 
 

1. It allows for easier access by learners on various 
devices 

2. It allows learners outside of your institution to 
also benefit from your material (participate in 
Free Open Access Medical Education: FOAMed). 

3. Instructors from other institutions can 
incorporate your materials into their teaching, 
thus broadening your impact. It demonstrates 
international adoption of your teaching materials 
(often with testimonials to include in your 
promotions packet). 

4. Let the big websites handle the streaming, 
storage and video & comment management  

 
To the right, you can see the analytics for a 
FlippedEMClassroom.wordpress.com. As of April 2015, 
when this screenshot was taken, the site was accessed 
around the globe. 
 
Some commonly used public repositories include: For videos: 

● YouTube (www.youtube.com)  
● Vimeo (www.vimeo.com)  

 
For written materials 

● MedEd Portal (www.MedEdPortal.org) Your own website or blog 
● WikiSpaces Education (www.WikiSpaces.com) 
● WordPress (www.wordpress.com, www.wordpress.org) o Weebly (www.weebly.com) 
● SquareSpace (www.SquareSpace.com)  
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Part 6: Design Classroom Activities 
 
Begin the class by using a focusing activity.  This tasks the learners with using the background materials. 
Some possible ideas:  
 

● Ranking 
● Question and Answer time 
● Think-pair-share 
● Identify 1 confusing point 
● What if? 

 
Then move on to the main classroom activity. These should explore Bloom’s higher domains such as 
application, analysis, evaluation and creation, and synthesis. The objectives should build upon the core 
knowledge learned from the home modules. Try to bring the lesson home and into the clinical realm. 

 
Here are some examples:  

● Application​: table top case scenarios and simulation 
● Analysis​: debate over controversies or journal articles, comparing diagnostic and treatment 

strategies, analyze the quality of a case management (from M&M or even a television show) 
● Creation​: have learners create and role play scenarios involving patients, family members, 

physicians and other health care team members for difficult conversations  
 
Allow the content to guide you. Support experimentation. For example, learning procedures should 
allow students to get out the simulators during class time. Using common tools (e.g., slit lamp) will need 
additional resources.  In general, discussion is a good place to start.  The conversational style is low risk 
and learners love the time to interact with each other and the teachers.  Branch out from here. 
Common themes include mind-mapping, content creation, projects, small group work, etc. 
 
Instruction is shifted from instructor-focused to learner-centered. Let learners lead the discussion as 
much as possible, ask questions of one another and teach one another. Teachers adopt a supportive, 
but far from passive role. The instructor’s job is to: 

 

1. Design activities that promote discussion between members of the group  

2. Help initiate discussion with probing, open-ended questions. Ask learners to: 

a. Explain or elaborate their ideas, 

b. Provide the rationale for their decisions, 

c. Ask for alternative methods to approach the problem, 

d. Link these concepts to previous material by creating a concept map 

e. Reflect on how well the group is completing the assignment predict outcomes, or  

f. Generate hypotheses.  

3. Provide feedback when learners are going off track or quiet  

4. Continually observe and make adjustments as appropriate.  
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Will the learners really teach each other? If learners attained the foundational knowledge outside of 
class and the classroom activity is properly created, there is usually spontaneous participation. When 
this happens, the instructor can simply step out of the way and observe. You become “the guide on the 
side” instead of the traditional lecturer role of “sage on the stage” (King 1993). As Dr. Eric Mazur said in 
his “Confessions on a Converted Lecturer” talk, our job should “shift [the] focus from teaching to helping 
learners learn.” 
 
Dr. Stephanie Velegol​ Professor of Environmental Engineering from Penn State flipped her classes and 
following this paradigm:  
 

PRIMING VIDEOS 
PRE-SESSION 
ASSESSMENT 

IN CLASS 
EXERCISES 

WEEKLY QUIZ 

 
1. PRIMING:​ Give students an activity to draw upon the knowledge they already possess. Ask them 

to solve a problem before you have taught them how. This brings their prior knowledge to the 
foreground so they can hook new material into it.  

2. VIDEOS:​ ​She designed short videos using the material she had already created. Students would 
watch these at home.  

3. PRE-SESSION ASSESSMENT:​ ​Students would answer a short quiz at home after watching the 
videos. By having students answer questions on the video, she appealed to their extrinsic 
motivation (a small number of points toward their grade) to ensure they watched. Additionally, 
the last question was “what was the point you least understood?” (muddiest point). After 
reviewing all the student’s answers, she would dedicate a few minutes at the beginning of class 
to clear up misconceptions the whole group had.  

4. IN CLASS EXERCISES:​ ​Class time was dedicated to students going through the homework. They 
could work together or alone. If they run into trouble, they have the benefit of having the 
instructor right there to answer questions. Attendance was not mandatory at these sessions 
(some students study better at home in quiet), but she found usually these were well attending.  

5. WEEKLY QUIZ:​ ​At the end of each week, students had a quiz on the material to assess their level 
of mastery. Students had to achieve a level of 75% or higher. If they failed to do so, there was no 
penalty. Students were directed back to the videos and homework to re-learn what they got 
wrong. They could reattempt the quiz as many times as needed to achieve the passing score. 
This ensured all students achieved the same level of mastery.  
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Eric Mazur, Professor of Physics at Harvard University, champions peer learning in his classroom. While 
not technically a flipped classroom, this technique lends itself well to in class activities. 

 

 

He first teaches a concept, using a combination of slides and 
demonstrations.  

 

He then challenges his students with a question to answer using the 
concepts he just taught. They do this separately answering using an 
audience response system.  

 

Once all students have answered,  

 

and he has tallied their responses, 

 

he encourages them to teach each other. Dr. Mazur notes that the 
expert is not in the best position to teach novices. The depth of our 
knowledge prevents us from appreciating the difficulties that those 
new to the material face. Peers, on the other hand, are best suited to 
teach each other.  

 

He circulates through the class and clarifies points as well. However, 
this discussion is entirely student run. The classroom is fairly loud at 
this point.  
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Finally, once everyone has answered, he reviews the concepts again. 
If you’re interested in learning more about his technique, here are two 
excellent videos: 

● Peer instruction (8 minutes): 
https://www.youtube.com/watch?v=wont2v_LZ1E   

● Confessions of a Converted Lecturer (1 hour): 
https://www.youtube.com/watch?v=WwslBPj8GgI  

 
Of course, these are just two of many ways to run your in class sessions. Try to let the students have 
autonomy to discuss, teach and explore. Step in only when they deviate greatly from the path or ask for 
help. “Be the guide on the side instead of the sage on the stage.” 
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Part 7: Enhancing Learner Motivation 
 
There are two types of motivation: external and internal. Students who are responding to external 
motivators are driven by achieving rewards or avoiding penalties. This is our typical method of 
motivating students: grades in class or on boards. This will still play a role as we still need to give 
grades.  
 
Internal motivation is a deeper stimulus. It comes from within. There are several models of 
self-motivation, the overlap boils down to these four principles.  
 

Mastery / 
Competence 

Purpose 
Relatedness / 

Support 
Autonomy 

 
The flipped classroom allows students to achieve each of these needs.  
 

1. MASTERY & COMPETENCE:​ ​students are driven by the knowledge that they can do well. They 
can pause and rewind lecture videos until they understand a concept instead of getting lost in a 
lecture that plods forward without them. Mastery learning techniques ensure students do not 
progress until they achieve a level of competence.  

2. PURPOSE:​ they need to see the value in what they are doing. The more an activity relates to 
what they would use in real-life, the more value is placed on the activity. For us, this translates 
to patient care. We can design genuine activities that mimic the day-to-day activities of a 
physician through cases, simulation or other activities.  

3. RELATEDNESS & SUPPORT:​ Students are better motivated when they feel part of the team. 
Students teach each other in class. They can approach the instructor to give them individual 
focused attention where they are having trouble.  

4. AUTONOMY:​ Students are better motivated when they have some degree of control of over 
their learning. With video lectures they are able to control how, when and where they learn the 
material. In class, students run the discussion. 
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